MSITA: Excel 2013		Chapter 3
Lesson 3: Using Office Backstage
Step-by-Step 1 – Access Backstage View
GET READY. LAUNCH Excel and OPEN a blank workbook.
1. Click the FILE tab to display Backstage view with the Open tab selected (see Figure 3-1).
2. In the upper left corner of Backstage view, click the Return to document button.
3. In cell A1, type abc and press Enter.
4. Click the FILE tab. Backstage view, like the ribbon, is context-sensitive and changes to the Info tab
5. Click the Save tab. Notice that there are additional tabs depending on your setup. In this case, SkyDrive, Computer, and Add a Place appear.
6. Click the Save As tab. Notice that this looks identical to the Save tab. This is how it looks the first time you save the file.
7. Click Computer and notice that the Recent Folders section where you last saved your previous workbooks appears.
8. Click Browse. In the File name box, type Temp, and then click Save.
9. Click FILE. Notice the Info tab appears.
10. Click Save. Notice that you do not see the options shown in Figure 3-3 in the MOAC text (and Step 5 previously), but that you return directly to the workbook.
11. Click FILE and click Close. This action closes the workbook, but not Excel.
12. Click FILE and the Open tab appears. In the list of Recent Workbooks, select Temp and your workbook returns.
PAUSE. Close Excel.
Step-by-Step 2 – Print and Preview a Document
GET READY. LAUNCH Microsoft Excel 2013.
1. Create a new workbook, enter the worksheet data, and save it as 03 Contoso Potluck solution in a folder called Excel Lesson 3.
2. CLOSE Excel.
3. LAUNCH Excel again and notice that 03 Contoso Potluck Solution appears in your Recent list. Click the file to bring it back up.
4. Click the FILE tab to automatically display the Info tab. As shown in Figure 3-5, the Properties area shows the size of the file, when it was last modified, and who the author is.
A handy feature, Open File Location, allows you to open the folder where the current file is located.
5. Click the Print tab. Note that this displays the Print options in Backstage view. Take a moment to preview the workbook in the Print Preview section in the right pane and read through the Print options listed in the center section of the page.
6. To print your worksheet, at the top of the Print screen, click the Print button.
PAUSE. LEAVE the workbook open for the next exercise.
Step-by-Step 3 – Use Quick Print to Print a Worksheet
GET READY. USE the open workbook from the previous exercise or open 03 Contoso
Potluck Solution.
1. On the Quick Access Toolbar, if you do not see the Quick Print button, click the
Customize Quick Access Toolbar arrow at the end of the toolbar, and select Quick Print.
2. On the Quick Access Toolbar, click Quick Print (do NOT actually click on Quick Print, just be sure that you know where it is located).
3. Retrieve the printed copy of the worksheet from your printer.
4. Click the FILE tab, and then click Print. The preview pane should match what was printed.
5. Click the Return to document button.
6. Notice that a dotted vertical line appears in the middle of the screen. The line shows the right edge of the printed page. The line displays the first time you print or preview a page.
PAUSE. LEAVE the workbook open for the next exercise.
Step-by-Step 4 – Set the Print Area
GET READY. USE 03 Contoso Potluck Solution that is already open or create the workbook shown in Figure 3-4 in the MOAC text.
1. Click the PAGE LAYOUT tab.
2. In the Page Setup group, point to the Print Area button. Note the ScreenTip that displays and defines the task to be completed.
3. On the worksheet, click cell A3, hold the mouse button, and drag to cell A13. Your cell range should be highlighted in gray.
4. With these cells highlighted, from the menu that appears, click the Print Area dropdown arrow and click Set Print Area. You have now set the print area. While the area is still selected, note that the Name Box now says Print_Area.
5. Click the FILE tab to open Backstage view.
6. Click Print and notice in the Print Preview pane that you can see only the list of items to bring and not the text in rows 1 and 2 and columns B and C.
7. Click the Return to document button. You will not print at this time.
PAUSE. SAVE the workbook in your Lesson 3 folder with the current name 03 Contoso Potluck Solution and CLOSE Excel.


Step-by-Step 5 – Print Selected Worksheets
GET READY. LAUNCH Excel 2013, and then perform these steps:
1. OPEN 03 Contoso Potluck Depts. This is a modified version of the potluck workbook you created previously. In this case, there are three different worksheets for three different departments.
2. Click each of the three worksheet tabs: HR, Operations, and Finance. Notice that the title in C1 shows the department name and there are a different number of items to bring to each potluck depending on the size of the department. Click the HR tab.
3. Press Ctrl + P to display the Print options in the Backstage view. In the Print Preview pane, the entire worksheet does not display (see Figure 3-11 in the MOAC text). This is because of the selected print area.
4. Press Esc or click the Return to document button.
5. Click the PAGE LAYOUT tab, click Print Area, and then select Clear Print Area.
6. Click the FILE tab and click Print. Notice that the entire worksheet for HR appears.  Also notice that the page number shows 1 out of 1 indicating that only one of the worksheets will print, and it will all fit on one page.
7. In the Settings section of the center pane in Print options, click the Print Active Sheets drop-down arrow. In the drop-down menu that appears you can select several printing options for your workbook or worksheet.
8. Click the Return to document button.
9. While the HR worksheet is active, hold down Ctrl and click on the Finance tab. Now both the HR and Finance worksheets are selected.
10. Click the FILE tab and click Print. Now in the Print Preview area, the bottom of the screen shows 1 of 2 with the HR worksheet preview. Click the right arrow to go to the second page and notice that the Finance worksheet previews.
11. Click the Return to document button to return to the workbook without printing.
PAUSE. CLOSE the workbook without saving. LEAVE Excel open for the next exercise.
Step-by-Step 6 – Print Selected Workbooks
GET READY. With Excel open from the previous exercise, perform the following steps:
1. Click the FILE tab and click Open if it is not selected. Because you just used the 03 Contoso Potluck Depts workbook, it should be at the top of the list of the Recent Workbooks.
2. Click 03 Contoso Potluck Depts to open it.
3. Click the FILE tab and click Print.
4. Notice that the complete worksheet for HR does not display. This is because you did not save the workbook after you cleared the print area. Clear the print area as you did in Step 5 of the previous section and return to the Print tab of Backstage view.
5. In the Print window’s Settings options, click the Print Active Sheets drop-down arrow and click Print Entire Workbook (see Figure 3-15). You will not print at this time.
PAUSE. CLOSE Excel and do not SAVE the workbook.
Step-by-Step 7 – Apply Print Options
GET READY. LAUNCH Excel, OPEN 03 Contoso Potluck HR, and make sure the HR-P1 worksheet is selected.
1. Click the FILE tab and select Print (see Figure 3-16). Notice that the worksheet is small and it might be nice to have lines for people to write in on a printed page.
2. In the Settings section of the Print window, click the Margins drop-down and click Wide (see Figure 3-17). The new margins will allow the worksheet to be hole-punched and put in a binder.
3. Click the Scaling drop-down and see the choices below (see Figure 3-18). The scaling options ensure that all columns, rows, or the entire worksheet fit on one page.
• Current choice is No scaling, so the document prints the same size as the screen.
• If you want to fi t everything that is on the worksheet on one page, select Fit Sheet on One Page.
• If there are just a couple of columns extra, click Fit All Columns on One Page.
• If there are just a couple of rows extra, click Fit All Rows on One Page.
4. In this case, you make the text larger without changing the font. Click Custom Scaling Options. The Page Setup dialog box opens.
5. Make sure that the Page tab is selected and select Landscape so the page prints horizontally.
6. In the Scaling area, type 200 for the % normal size (see Figure 3-19).
7. Click the Sheet tab and in the Print section, select the Gridlines box.
8. Click OK to return to Backstage view. Notice that the bottom of the screen still says, 1 of 1, meaning that only one page will print and notice that Print Preview shows larger text with boxes around each cell (see Figure 3-20).
9. Without printing the document, click the Return to document button and then click the 
HR-P2 worksheet.
10. Press Ctrl + P to go to the Print tab of the Backstage view and notice that the bottom of the screen indicates that the document will print on two pages.
11. Change the Settings to print Landscape, to Fit Sheet on One Page, and add gridlines based on the previous steps in this section. Print Preview should look like Figure 3-21.
12. SAVE the workbook in your Lesson 3 folder as 03 Contoso Potluck HR Print Ready Solution.
PAUSE. LEAVE the workbook open for the next exercise.
Step-by-Step 8 – Change a Printer
GET READY. Continue with the previous workbook or if necessary, open 03 Contoso
Potluck HR Print Ready Solution.
1. Press Ctrl + P to display the Print tab of the Backstage view.
2. Your current default printer is displayed in the Printer options section of the Print tab.  Click the Printer drop-down arrow to produce a menu of installed printers, similar to the one shown in Figure 3-22. Your printers will be either Ready or Offline.
3. Click on a printer (other than your default printer) in the printer list. This printer should now be visible as your active printer. Should you attempt to print at this time with an inactive printer, you will get an error.
4. Once again, click the Printer drop-down arrow, and select your default printer (the one with the checkmark).
PAUSE. CLOSE your workbook and don’t save if prompted.
Step-by-Step 9 – Customize the Quick Access Toolbar
GET READY. OPEN a blank workbook in Excel.
1. Click the FILE tab to access Backstage view.
2. In the navigation pane, click the Options tab. The Excel Options dialog box opens.
3. In the left pane of the dialog box, click Quick Access Toolbar to display the Quick Access Toolbar options (see Figure 3-23). In the right pane, the list on the left includes the commands that you can add to the toolbar. The list on the right shows the commands that are currently included on the toolbar.
4. In the list on the left, scroll down and click Format Painter, and then click the Add button in the center of the two lists to add the Format Painter to the Quick Access Toolbar.
5. Using the same process, move fi ve more commands you use often to the Quick Access Toolbar. When you are done, click OK to apply your changes (the changes don’t take effect until you click OK).
6. Your Quick Access Toolbar should now include additional command buttons, much like the example shown in Figure 3-24. Similarly, you can remove any command that you added to the toolbar. At any time, you can reset the toolbar to its default settings. See the Reset button in Figure 3-23.
PAUSE. CLOSE Excel.
Step-by-Step 10 – Customize the Ribbon
GET READY. OPEN a blank workbook in Excel.
1. Click the FILE tab to open Backstage view.
2. Click the Options tab.
3. In the Excel Options dialog box, click Customize Ribbon. The Customize the Ribbon options appear (see Figure 3-25). By default, Popular Commands is selected in the Choose Commands From drop-down box. The list of Popular Commands appears in the list below the drop-down box. Also, by default, the Main Tabs option appears in the Customize the Ribbon box on the right, with the ribbon’s main tabs listed below.
4. In the list of Popular Commands, click Format Painter. Note the Add button in the center of the dialog box is now active.
5. In the Customize the Ribbon list on the right, click the + preceding Home to expand the list of command groups within the Home tab if it isn’t already expanded. You can use this method to display the current groups available on a ribbon tab.
6. Under the Customize the Ribbon options, click the New Tab button (see Figure 3-26) to insert a new blank tab into the Customize the Ribbon list. When you create a New Tab, New Group is automatically created inside that New Tab.
7. Click the New Tab (Custom) list item on the right to select it, and then click the Rename button. In the Rename dialog box that appears, type My New Tab (see Figure 3-27), and then click OK.
8. Under your new tab, click New Group (Custom) to select it. Click the Rename button again. This time, the Rename dialog box allows you to select a symbol (see Figure 3-28). Select the hand symbol. In the Display name box, type My New Group, and then click OK. You see the New Group renamed.
9. In the Customize the Ribbon list on the right, click the My New Group list item. In the command list on the left, click on a command of your choice, and then click the Add button. The command appears on your new ribbon tab. In the Choose commands from list, select All Commands and then add another command from this list. In the Choose commands from list, select File Tab and then add another command. Your screen should look similar to Figure 3-29.
10. Click OK to close the Excel Options dialog box. When you exit, you see your tab named My New Tab on the ribbon.
11. Click the My New Tab tab. Your commands display in the tab’s My New Group 
(see Figure 3-30).
PAUSE. LEAVE the workbook open for the next exercise.
Step-by-Step 11 – Customize the Excel Default Settings
GET READY. Continue with a blank workbook from the previous exercise.
1. Click the FILE tab to open Backstage view.
2. In the navigation pane, click Options. By default, the Excel Options dialog box opens with the General options displayed.
3. In the When creating new workbooks section, click in the Include this many sheets text box and type 5 to change the number of worksheets that appear by default in new workbooks.
4. In the Personalize your copy of Microsoft Office section, click the User name box and type [your first and last name] in the text box (see Figure 3-31). Click OK.
5. CLOSE and RESTART Excel and select Blank workbook. Note that instead of one worksheet tab, you now have fi ve in your workbook (see Figure 3-32).
PAUSE. LEAVE the workbook open for the next exercise.
Step-by-Step 12 – Reset Default Settings, the Ribbon, and Quick Access Toolbar
GET READY. Continue with a blank workbook from the previous exercise.
1. Click the FILE tab, and click Options.
2. On the General tab, in the When creating new workbooks section, in the Include this many sheets box, type 1.
3. Click the Customize Ribbon tab.
4. In the bottom right of the dialog box, click the Reset button, and then click Reset all customizations.
5. In the Confirmation dialog box, click Yes to clear all ribbon and Quick Access Toolbar customizations for this program.
6. Click OK to return to the workbook.
The ribbon and Quick Access Toolbar changes are immediate, but you need to open a new, blank workbook to notice the change for the number of displayed workbooks.
PAUSE. LEAVE the workbook open for the next exercise.
Step-by-Step 13 – Select a Template from the New Tab
GET READY. If necessary, OPEN a blank workbook.
1. Click the FILE tab and click New. The New window displays as shown in Figure 3-33, with a series of featured templates. You already used the Blank workbook template in this book.
2. Scroll down if necessary, and click the Project Tracker icon. Figure 3-34 shows a larger window with a larger picture and description of the template.
3. Click the Create button. Excel might take a moment to download the workbook.
4. Notice that there are two worksheets in this workbook: Project Tracker with the sample data you can change and Setup that allows you to input a list of categories and employees. When you are fi nished looking at this template, click FILE and click Close. If prompted, do not save changes.
5. Click the FILE tab, click New.
6. Look for Any year calendar template and click the Create button.
7. Click on the year and use the up or down arrow to change to the current year if necessary.
8. Print the worksheet and put on your wall, if desired.
9. SAVE the workbook in your Lesson 3 folder as 03 My Calendar Solution.
10. Click the FILE tab and click New. Notice that the Any year calendar template appears as the third item on your list of templates because it was recently used.
PAUSE. CLOSE the workbook and LEAVE Excel open for the next exercise.
Step-by-Step 14 – Search for Additional Templates
GET READY. If necessary, OPEN a blank workbook.
1. Click the FILE tab and click New. Notice the Suggested searches and Search for online templates box.
2. Click Budget on the Suggested searches row. As shown in Figure 3-35, the New window changes to show templates specifically related to working with budgets.
3. Scroll to the bottom of the window and click on a few templates to see their descriptions.
4. Scroll back to the top of the New window and click Home to return to the original templates screen.
5. In the Suggested searches row, click Calendars.
6. In the Category pane to the right, click Student.
7. Scroll to the Student assignment planner, click it, and read the description. Close the template description window.
8. In the Search box, type College and press Enter. Scroll through the list of suggested templates for college students and open the Weekly college schedule template.
9. In cell B1, type in [Monday’s date], and then review the workbook.
10. SAVE the workbook in your Lesson 3 folder as 03 My Weekly Schedule Solution. Click Yes when prompted to save this as a macro-free workbook.
Macros allow you to automate your tasks. Some templates come with macros to make your work even quicker. Macros are discussed in Lesson 9, “Saving Work with Macros.”
PAUSE. CLOSE Excel.
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